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Welcome to CD Browser Help. In addition to this 
introduction, this document contains these sections to help 
you learn.

Using CD Browser Offers instruction on completing single 
tasks. 

Reference Describes menu commands, the workspace, and
dialog boxes. It also has an advice section.

Contacting Ulead How to contact Ulead Systems when you
need advice or have comments.

File Menu
Workspace
Menu commands
Dialog boxes
Advice

The File menu contains these commands. Click on the one 
you have a question about for more information.

 Load Photo CD
 Open to PhotoImpact
 Insert Thumbnails into Album
 Save As
 Select All
 Select None
 Select Invert
 Preferences
 Exit

Click Menu commands on the left for help on other CD 
Browser menus.

View Menu
Workspace
Menu commands
Dialog boxes
Advice

The View menu contains these commands. Click on the one
you have a question about for more information.

 Open to Viewer
 Disc Properties
 Photo Properties

Click Menu commands on the left for help on other CD 
Browser menus.



Help Menu
Workspace
Menu commands
Dialog boxes
Advice

The Help menu contains these commands. Click on the one 
you have a question about for more information.

 Ulead PhotoImpact CD Browser Help 
 About Ulead Products 
 About PhotoImpact CD Browser 

Click Menu commands on the left for help on other CD 
Browser menus.

Dialog boxes
Workspace
Menu commands
Dialog boxes
Advice

These are the dialog boxes in CD Browser. Click on the one 
you have a question about for information about each option
it contains. When applicable, the help includes advice for 
making decisions.

File Menu View Menu
 Save As  Disc Properties
 Preferences  Photo Properties
 Insert into Album

Nested dialog boxes
 Browse     PNG Save Options
 BMP Save Options     PSD Save Options
 EPS Save Options     RAS Save Options
 GIF Save Options     TGA Save Options
 IFF Save Options     Thumbnail Description
 JPEG Save Options     TIFF Save Options
 New Album     UFO Save Options

Advice
Workspace
Menu commands

           Dialog boxes  
Advice

Here are tips, techniques, and other tidbits to help you 
understand and use CD Browser better.

    The downside to opening images at high resolution 
    Why insert thumbnails into albums?

General
General
Image management
Viewing

 Starting CD Browser
 Setting CD Browser defaults
 Quitting CD Browser

Image management
General
Image 

 Selecting thumbnails
 Editing images



management
Viewing

 Saving to albums
 Saving images

Viewing
General
Image management
Viewing

 Viewing images
 Changing image properties
 Obtaining information 

 File Menu
 View Menu
 Help Menu
 Switch Menu



 CD Browser toolbar
 Status bar



Reading this Help
Welcome
What is CD 

Browser?
Reading this Help

This help contains several aids to make navigating through 
topics easier.

Jumps to the shown topic.

Pops up extra information to enhance understanding.

Pops up tips or advice to help you work more efficiently.

Returns you to the top of a page after scrolling in a main 
window.

What is CD Browser?
Welcome
What is CD 

Browser?
Reading this Help

CD Browser makes cataloging and viewing Kodak Photo CD
(PCD) images on a CD quick and easy. It automatically 
creates a "photo album" consisting of miniature images, 
called thumbnails, of each photo on the CD inserted in your 
CD-ROM drive. By selecting the thumbnail you are 
interested in, you can view the image at a variety of sizes or 
open it in an image editing program.

You can obtain Kodak Photo CDs from computer software 
stores or create your own by going to any authorized Kodak 
film developing center. By putting your favorite photographs 
on Photo CDs you can have a permanent record of an 
image without any fear of degradation over time.

Note: CD Browser only works with CDs containing images 
using the Kodak PCD file format.



Starting CD Browser
Manually
1. Insert a Photo CD into a CD ROM drive. (CD Browser cannot start unless a Kodak Photo CD is inserted.)
2. Double-click the CD Browser shortcut or program icon.

Automatically
Copy the Ulead Quick Start program (not the shortcut) from your PhotoImpact folder to the Windows 95 

StartUp Menu. As soon as you insert a Photo CD, CD Browser starts.

Setting CD Browser defaults



Obtaining information
 Photo properties

To see image history and copyright information, select a thumbnail and click the Image Information Icon. Click the 
Copyright button to open a text file in Notepad with copyright information.
Note: Some photos have a copyright even if none is shown. Always assume one exists unless you know for certain 
that it does not.

 Photo CD properties
Click the CD Information button to see the history and serial number for the current CD.

CD Browser information

The toolbar shows the selected CD-ROM drive, the image resolution, and data type settings for viewing or editing 
images.

Program information

The status bar changes according to mouse location. Usually it shows the number of images in the current CD, how 
many are selected, and the total file size for all selected images. When the pointer covers a menu command or 
toolbar item, it offers a brief explanation of the command or function.



Changing image properties
Choose the desired data type and image size from the drop-down boxes in the CD Browser toolbar. You can view 
photos as RGB true color, indexed 256-color, or grayscale images at the following resolutions:
       64 x 96
  128 x 192
    256 x 384
    512 x 768
1024 x 1536
2048 x 3072
4096 x 6144



Saving images
1. Select the thumbnail for the image you want to save.
2. From the File menu, choose "Save As."
3. Assign a name, path, and format for saving the file. (You cannot save the file to the CD.)
4. Click OK.



Selecting thumbnails
Normal Just click on a thumbnail to select it. To select a range, click on the first thumbnail, then, while 

pressing the Shift key, click on the last. To select several thumbnails non-sequentially, press the Ctrl key as you click 
on each thumbnail.

All To select all thumbnails, from the File menu, choose "Select All."
Switching To de-select all selected thumbnails and select all unselected thumbnails, choose "Select Invert."

Note: Selected thumbnails appear with a red border around them.

Saving images
Saving to albums
Editing images



Setting CD Browser defaults
1. From the File menu, choose "Preferences."
2. In the Preferences dialog box, select the desired CD ROM drive, image size, data type, and background colors for 

CD Browser.
3. Click OK to accept the settings.

Note: You can change the CD-ROM drive, image size, and data type directly from the ribbon.



Saving to albums    
1. Select the thumbnails you want to insert into an album.

2. In the toolbar, click "Insert Thumbnails into Album." 
3. In the Insert Thumbnails into Album dialog box, select the desired album. (Optionally, add an explanation or 
description for the image.)
4. Click OK.

Note: PCD image thumbnails stored in albums open using size and data type settings matching the default Photo-CD
settings.

Why insert thumbnails into albums?
Setting CD Browser defaults



Quitting CD Browser
From the File menu, choose "Exit."



Viewing images
Single 

Set the desired image size and data type in the ribbon and then double-click on the thumbnail for the image you want 
to see. 

Multiple
1. Set the desired size and data type in the ribbon
2. Select the thumbnails for images you want to see.
3. In the toolbar, click "View Photo." 

The downside to opening images at high resolution



Editing images
You cannot actually use CD Browser to edit images, but you can transfer images into PhotoImpact for editing:
1. Set the desired size and data type in the ribbon
2. Select the thumbnails for images you want to edit.
3. In the toolbar, click    "Open to PhotoImpact." 



Load Photo CD
Loads thumbnail images from the Photo CD in the CD-ROM 
drive identified in the tool bar into the CD Browser 
workspace. 

Insert Thumbnails into Album.

Allows you to insert selected thumbnails into a new or 
existing Album file.

Saving to albums

Save As
Saves the image for the selected thumbnail as a file for 
future editing or use. The saved resolution and data type 
depends on the tool bar settings.

Saving Images

Select commands
Selected thumbnails have a red border inside the thumbnail 
frame. Once selected, you can choose other commands to 
act on selected thumbnails.

 Select All Selects all thumbnails for images on the CD.
 Select None De-selects all selected thumbnails.
 Select Invert Selects all unselected thumbnails and 

deselects selected ones.

Selecting thumbnails

Preferences
Accesses the Preferences dialog box where you can choose
the default drive for Photo CDs, workspace background 
color, image data type, and image size. It also offers options
for managing memory while Ulead programs are running 
and calibrating your display for best viewing conditions.

Setting CD Browser defaults

Exit
Closes CD Browser.

View Photo
Starts Viewer loading the images for all selected thumbnails 



in its workspace.

Viewing images

Disc Properties
Opens a dialog box with information about the current Photo
CD:

Serial number The Photo CD's identification 
number.

Creation time The date and time the CD was 
created.

Modification time The last time images were 
added to the CD.

Sessions How many times images were added to 
the Photo CD.

Photo Properties
Opens a dialog box with information about the image for the 
selected thumbnail:

Creation time The date and time the image was 
created as a file.

Modification time The last time the image was 
changed.

Has copyrights? Tells whether the image has a 
registered copyright. Note: A copyright may still exist even if 
this line states otherwise.

Photo finisher Shows other information the author
wanted to include.

Copyrights Opens the copyright    document on 
the CD in Notepad with detailed copyright information about 
the Photo CD and its images.

Note: This command is disabled when more than one 
thumbnail is selected.

CD Browser toolbar
Workspace
Menu commands
Dialog boxes
Advice

The toolbar puts all the most frequently used CD Browser 
features in one location for easy access. Click above to 
learn more about each item.

Click Workspace on the left for help on other workspace 
items.



PhotoCD CD-ROM Drive

Choose the drive for your Photo CD.



Size and Resolution

Choose the image size and data type for viewing or editing in other programs.



Status bar
Workspace
Menu commands
Dialog boxes
Advice

The Status bar provides quick information about selected 
thumbnails, menu commands, and screen components. 

Click Workspace on the left for help on other workspace 
items.

Why insert thumbnails into albums?
By putting your favorite pictures in albums, you can easily 
keep track of your favorite files without tying up huge 
amounts of system resources and disk space. Album stores 
a thumbnail of the image with a link to the actual file on the 
CD. You can review albums with or without the CD present, 
and when you want an image, the album tells you which CD 
to insert to access it.

Open to PhotoImpact
Starts PhotoImpact, loading all images for selected 
thumbnails in the PhotoImpact workspace.

Note: If no thumbnails are selected, CD Browser still opens 
PhotoImpact.

Editing Images

The downside to opening images at high resolution
For viewing images on your PC, there is little advantage to 
choosing a size larger than your display resolution. Anything
larger will either be scaled down to fit on the screen, or 
require you to use scroll-bars to view different portions of the
image. Further, as you increase image size, the amount of 
time and memory required to open and display images 
increases significantly. While it may only take a second or 
two to open a 512 x 768 image, it could take several 
minutes to open a 4096 x 6144 one.

About PhotoImpact CD Browser
Shows the CD Browser program information box containing 
copyright, revision, and registration information about the 
program.

Help Button
Allows you to use your mouse to access the on-line help 



about a command, button, or workspace item.



File dialog boxes
This class of dialog boxes allows you to decide the names, locations, and characteristics for files when opening or 
saving them. They may contain some or all of the following choices:

Look in/Save in Find the desired folder.
View the contents of the next higher folder in your system.
Create a new folder.
List names.
List names with statistics.
File name Identify the file(s) selected for saving, opening, or loading.
Files of type Select a particular file format for opening or saving to.
File information See the data-type, size, resolution, and other file statistics.
Preview View a thumbnail picture of the selected image. (Images with preview information automatically 

appear.)
Options Define format specific save options for the selected format. (Not all file formats have options.)
Browse Search for files or folders.
Network Access shared folders on other connected computers running Windows.
Save to Album Save a thumbnail image of the file to the listed album.
Album button Select or create an album for the thumbnail images.



TIFF Save Options dialog box
Format Choose to save the file for use on an IBM PC- compatible or Apple Macintosh system.
Compression Choose the compression method to apply to the file.
Strip size Try the default setting of 8 first. If you need a smaller file, increasing the strip size may help.
Tile size If varying the strip size still does not produce adequate compression, try varying the tile size.
Include preview information Saving a preview makes the file a little bigger but allows some programs to 

display the image without actually opening it.



IFF, PSD, TGA, & UFO Save Options dialog box
Choose Run Length Encoding (RLE) for a smaller file size. If you have problems save it again without compression.



RAS Save Options dialog box
Compression Choose Run Length Encoding (RLE) for a smaller file size. If you have problems save it 

again without compression.
Byte order Try Most Significant Byte (MSB) first.
Color order Try BGR first.



JPEG Save Options dialog box
Quality Lower quality results in smaller files at the cost of image quality. The default setting offers good 

compression without significantly affecting the image appearance.
Progressive compression Check to enable the file to open progressively. This also places preview 

information in the file which enables some programs to view the file without actually opening it.



EPS Save Options dialog box
Format The ASCII format is more widely accepted but results in a larger file size. Binary EPS files are about

half the size of the same ASCII files.
Clipping path Set low to trace object shapes more accurately in the EPS file. This may be useful if you wish

to add text on a path in another program.
Preview TIFF Saving a preview makes the file a little bigger but allows some programs to display the image 

without actually opening it.



BMP Save Options dialog box
Choose whether to save the file as an MS-Windows or OS/2 bitmap.



Browse dialog box
File name Define the search criteria for finding files. You may use the * and ? wildcards to find files with 

similar names.
Files found Select the desired files from the list showing all files matching the search criteria. (Use the Shift 

and Ctrl keys just like multiple files.
Folders Select the folder to start the search from.
Drives Select the drive where the folder you want to search is located.
Sort Files Select the sorting order and whether to start from first to last (ascending), or last to first, 

(descending).
Scan Expand the search to include any folders inside the selected folder.
Delete Permanently remove selected files in the Found list from the hard disk.
Rename Change the name of selected files in the Found list from the hard disk.
Network Access shared folders on other connected computers running Windows.



Insert Thumbnails into Album dialog box
Places thumbnails of newly saved image files int an existing album.

Album Choose the album to insert the thumbnail into from the dropdown list.
Thumbnail Information Shows the filename and description information for the thumbnail.
New Album Click to create a new album to hold the thumbnail.
Description Click to add a description for the thumbnail.
Apply to all Click to use the same description for all thumbnails.



New Album dialog box
    General
    Fields 
    Advanced 

Determines the name location, and size characteristics for a new album.
Title Enter the title for the album.
Create Album File in folder Initially displays the current folder. Enter the desired folder or click Browse.
Browse Click to search for other folders.
Thumbnails attributes list Enter the size, compression, and color for the thumbnails in the new album.
Description box Displays default project description. Enter new description,    add new fields, or use the 

default.



New dialog box
    General

    Fields
    Advanced 

Assigns fields for thumbnails in the album.
Field name Enter the field name to add or modify.
Field type Select the data types for each thumbnail. Add/modify/delete from the user-defined list. Note: 

Certain field types can be modified provided that the field name is not computer default field by clicking on the Edit 
button. 

Add button Click to add new field name to the fields list.
Change Click to change the selected field name's current field type.
RemoveClick to remove field name from the fields list.
Total fields Displays the total number of fields in the album.
Fields list Displays the field names and their field types in the album.



New dialog box
    General 

    Fields 

    Advanced
Determines sharing and folder monitoring behavior for a new album.

Folder Enter the folder for monitoring.
Browse Click to search for other folders.
File types Enter the file format to monitor or select from the file formats drop-down list.
File formats list Select the file format to monitor.
Enable folder monitoring Check to monitor defined folder.
Password Enter a password for access security.
Verify Enter the password again for verification.



Choose JPEG compression for the smallest Album file size.



Thumbnail Description dialog box
Enter a description for the thumbnail being inserted into an album.



PNG Save Options dialog box
Interlace Check to allow images to open progressively when viewed on-line. This may increase file size.
Description Assign a brief description, key words, or other text message to store with the image.
Compression method Choose Compress more for the smallest possible file. Choose Compress faster to 

enable faster opening when viewed on-line.
Background color Click the color square to choose a color that appears as a background to the image.



GIF Save Options dialog box
Color table Displays the color palette of an image. Click on the color you wish to make transparent when 

the image is placed as an object.
Transparent color Displays the color that appears transparent when placed as an object into another 

image.
Save in Interlaced format Check to open the image progressively when viewed on-line. This may increase 

file size.



Preferences dialog box
 CD Browser
    Memory

    Display
The Preferences dialog box lets you determine the startup conditions for CD Browser. It offers these choices:

CD-ROM drive Select the CD-ROM drive for CD Browser to access Photo CDs from.
Resolution setting Set the image resolution for opening selected files.
Data type Set the data type for opening or viewing selected files.
Background color Select one of the four preset colors or select Custom color and click Pick Color to use a 

color from the Windows Color dialog box as the CD Browser workspace background.



Photo CD images can be displayed at the following resolutions (pixels):
64 x 96
128 x 192
256 x 384
512 x 768
1024 x 1536
2048 x 3072
5096 x 6144



Photo CD images can be displayed using the following data types:
RGB True-Color
Indexed 256-Color
Grayscale



Preferences dialog box
 CD Browser

    Memory
    Display

Optimize how Windows manages system memory while running Ulead programs.
Temp folders Choose folders for storing temporary files while running Ulead programs. (Windows 

automatically determines the first folder.)
Hard disk Displays available memory space in your hard disk.
Limit hard disk usage to Check this and specify a value for maximum disk space to have Ulead programs 

manage disk usage while running. This might be useful for preserving disk space for other files.
Limit RAM usage to Check this and specify a value for maximum memory    to have Ulead programs 

manage system memory while running. This might be useful if you run several different programs at once.



Preferences dialog box
 CD Browser

    Memory

    Display
Control how Ulead programs display graphics.

HiColor dithering Check this if your display mode is High-Color and you want True Color images to look 
their best on screen.

View images with a common palette Check this if you are working in 256-color mode and want to open 
grayscale and color images at the same time or when to compare 256-color images with each other.

Ignore background quality Check this to devote most system resources to viewing the active image. When
selected, inactive images may appear discolored.

Monitor gamma Check this to correct your display for manufacturers' differences and the environment. 
When checked, set the gamma value so that the calibration square appears to be a single color.



Make sure each of your temporary folders is on a different drive or partition.



This does not affect the actual data, it just affects appearance when not active.



Raising the value makes the lower half lighter; lowering makes it darker.



Some file formats do not offer any save options. In this case, the Options button is disabled.



This button only appears if you are running in Windows for Workgroups or Windows 95. 



The benefit of choosing this option depends on the image. 



This is most useful for images you are preparing for the WWW or other on-line services. It enables viewers to see a 
representation of the image faster, thus allowing them to decide faster whether to wait to download the entire image 
for viewing. It is also useful if you wish to automatically see a preview thumbnail in the Open Image dialog boxes for 
Ulead and other programs that support preview information.



When using compression, larger strip sizes offer higher compression ratios. However, some programs may not be 
able to read TIF files with large strip sizes.



Ulead PhotoImpact CD Browser Help
Starts the on-line help.
You can also access help topics by:

Clicking the help button and then clicking on the 
item of interest

Placing the mouse over an item of interest and 
pressing F1.

About Ulead Products
Opens the About Ulead help document. This provides 
insight into the history, philosophy, and products of Ulead 
Systems.

Switch
Opens a menu listing other Ulead programs for quick 
access.

Switch Menu
Workspace
Menu commands
Dialog boxes
Advice

The Switch menu opens a menu listing other Ulead 
programs for easy access.
Click Menu commands on the left for help on other menus.



Technical support
Technical support
How to contact us

Please prepare the following information before contacting 
us so we can offer you the best possible support:

The program name and serial number.
Nature of the problem.
Any error messages or dialog boxes that appear 

when the problem occurs.
System information including CPU, operating 

system, and any other programs running when the problem 
occurs.

If you write or fax us, please add printouts of the following:
AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD32.INI

Note: You can open most of these files at once by running 
SYSEDIT.EXE, found in your Windows program directory.

How to contact us
Technical support
How to contact us

Click below for more information on contacting us.
North and South America  

International

. Phone .

. Fax .

. Mail .

. BBS .

. E-Mail .

Call 

886-2-764-8599 



Send a fax to
886-2-764-9599



Send a letter to
Ulead Systems, Inc.
10 F, 111 Tung Hsing St,
Taipei, Taiwan, R.O.C.



Dial up the Ulead BBS at
886-2-764-7585 19200 bps (N,8,1)



Call

(310)-523-9393 

or toll free in the USA at 

1-800-858-5323



Send a fax to 

(310)-523-9399



Send a letter to
Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502



Dial up the Ulead BBS at

(310)-523-9389 19200 bps (N,8,1)



Send E-Mail to

support@ulead.com




